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Example 1 - Investigation of a Slender Nonsway Column

Determine the adequacy of a 4” x 20” column® with 3-#11 bars on each 14” side in a nonsway frame
with a clear height of 22’6”. Use k=1.0.

The concrete used is 6000 psi and the reinforcing steel is 60,000 psi.

The factored load values for the column under consideration are as follows:

P (kip) 115 kips

Top My (kip-ft) 279 ft-kips

Bottom M, (kip-ft)  -279 ft-kips =
— Label
Project:

. . . IspEqumn Marwal Example 2
From the File menu, choose New. Any input data is cleared and the default o Enginesr:
values are restored. [wang 15185 5P

1. From the Input menu, choose General Information. Dz Clls
e Input the PROJECT header. leci 51814 =l
e  Select ENGLISH units and ACI 318-14 code. fUiss R Ot
' English ’75' Irwestigation
e Select Biaxial for run axis, Investigation for run option and Yes for " Metic ¢ Design
Consider Slenderness? ~ R A
 About H-dsis ' Biaxial
® Choose OK.  About Y-duis
2. From the Input menu, choose Material Properties. Essiit dnemess? (O s @ Mg
e Input 4.5 for the CONCRETE STRENGTH. Change the REINFOR.CING = ] =
STEEL STRENGTH to 50. Other properties are computed and will be
accepted.
e Choose Ok.
x|
—Concrete—————— [~ Reinforcing Steel
Strength, F'c: |4.5 ksi Strength. fy: ISD ki
¥ Standard ¥ Standard
Elasticity, Ec: |3323.sa ksi EIasticity,Es:|2SDDD ksi
Max stress, fo |3.825 ksi

Beta[1]: ID.825 Compression-controlled strain limit,
Ultimate strain: ID.DDS Eps_yt: ID.EID‘I 72414

DK I LCancel |

From the Input menu, choose Section | Rectangular.

e Input 20 and 14 for the section width (along X) and depth (along Y).

e Choose OK.

! Based on Example 15.8.5 from Reinforced Concrete Design by Chu-Kia Wang, Charles G. Salmon, and Jose A. Pincheira, Seventh
Edition, 2007, John Wiley and Sons, Inc.
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Sides Different |

Top Baottorn Left Right
Mo, of bars: |2 |2 |1 |1
Barsize:  [#11 =| [#11 =] [#11 =] [#11 =]
Rectangular Section FZ| Clear cover: |1_5 |1_5 |1.5 |1.5 it

Wwidth (slong <) B in Cover to
Depth [along Y} 14 in " Transverse bars  © Longitudinal bars

oK | LCancel | Ok LCancel |

3. From the Input menu, choose Reinforcement | Sides Different.

e Input 2-#11 bars for Top and BoTTOM and 1-#11 for LEFT and RIGHT. Input 1. 5 in for the cover
and select LONGITUDINAL BARS.

e Choose OK.

4. From the Input menu, choose Slenderness | Design Column.
e Input 22 .5 for the column CLEAR HEIGHT.

e Check NONSWAY FRAME and select INPUT ‘K’ FACTORS.

e Choose OK.

Design Column Pz|
bz Az
Clear height: ’@ ft Clear height: 225 1
&+ Monzsway frame &+ Monsway frame
" Sway frame " Sway frame
Sway criteria Sway criteria
SumPelPel [I SumPelPel [I
SumPuPul [I SumPulPul [I
¥ ¥
Effective length factors Effective length factors
" Compute 'k' factors " Compute 'k’ factors
& |rput k' factars: & |nput k' factars:
knsk [T k(s [0 ksl [T KGsk [0
Copy to Y-duis Copy to X-duis
oK Lancel |

5. From the Input menu, choose Loads | Service.

e Under LIVE, input 71.875 for the AXIAL LOAD, 0 for the X-MOMENTS @ToP, 0 for the X-MOMENTS
@BoT, 174.375 for the Y-MOMENTS @Topr and -174.375 for the Y-MOMENTS @BOTTOM,

respectively.
e In column SUSTAINED LOAD keep default setting for dead load equal 100%.

e Choose INSERT to add the entry to the list box.

e Choose OK.
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Service Loads [g|
Ayial Load [kip]— -~ =Moments (k-] -Moments [k-ft] Sustained Load [%]
@ Top @ Bot @ Top @ Bot
Dead | [0 o o [ o 100
Live: | [71.875 [o o [174375  [174375 [o
wind | [0 o [ [ o [
ED: [o o [ [o o [o
Snow: | |0 o [ o o o
Inzert | Modify | Delete ‘

‘No. [P bdut, bdwb, Myt Myb] for each caze

QK. LCancel |

6. From the Input menu, choose Loads | Load Combinations.

o If the list displays thirteen combinations, choose only the second load combination U2 and delete all
the others by selecting them and using DELETE. Choose OK.

Load Combinations f'5_<|

Dead Live ‘wind EQ Snow

1.2 + |1E + |0 + |0 + |05
Inzert | Modify | Delete | Defaults|

| ComboDead  Live Wwind  EQ Shaow

ok Cancel

7. From the Solve menu, choose Execute.

e The solver of the program is started and, upon completion, displays the interaction diagram of the
section with the load point plotted within the diagram.

8. From the View menu, choose Results.
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e Page through the results file.
e Choose FILE | EXIT to quit the spView program and get back to spColumn.

9. From the File menu, choose Print Results.
e Select the printer to send the text results to.
e Choose PRINT.
10. From the File menu, choose Print Screen.
e  Select the printer to send the graphical results to.

e Choose PRINT.
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20x 14 in

Code: ACI 318-14

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Considered
Column type: Structural
Bars: ASTM A615

Date: 10/25/16

Time: 10:15:33

P (kip)

1600

(Pmin)

-600

(Pmin)

600
M (88°) (k-ft)

STRUCTUREPOINT - spColumn v5.50 (TM). Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F

Column: Wang 15.18.5
fc=4.5ksi

Ec = 3824 ksi

fc = 3.825 ksi
e_u=0.003in/in

Beta1l = 0.825

Confinement: Tied

fy
Es

e_yt=0.00172414 infin

Project: spColumn Manual Example 2

=50 ksi
= 29000 ksi

phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

Engineer: SP

Ag =280 in*2

As =9.36in"2

Xo =0.00in

Yo =0.00in

Min clear spacing = 3.39 in
kx(nonsway) = 1

ky(nonsway) = 1

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example02.col

6 #11 bars

rho =3.34%

Ix = 4573.33 in"4

ly = 9333.33 in"4
Clear cover = 1.50 in
kx(sway) = N/A
ky(sway) = N/A
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20x 14 in

600

My (k-ft)

Mx (k-ft)

Code: ACI 318-14

Units: English

Run axis: Biaxial

Run option: Investigation
Slenderness: Considered
Column type: Structural
Bars: ASTM A615

Date: 10/25/16

Time: 10:17:48

-600

P =115 kip

-600 -

1
600

STRUCTUREPOINT - spColumn v5.50 (TM). Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F

Column: Wang 15.18.5
fc=4.5ksi

Ec = 3824 ksi

fc = 3.825 ksi
e_u=0.003in/in

Beta1l = 0.825

Confinement: Tied

Project: spColumn Manual Example 2

fy =150Kksi
Es =29000 ksi
e_yt=0.00172414 in/in

phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

Engineer: SP

Ag =280 in*2

As =9.36in"2

Xo =0.00in

Yo =0.00in

Min clear spacing = 3.39 in
kx(nonsway) = 1

ky(nonsway) = 1

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example02.col

6 #11 bars

rho =3.34%

Ix = 4573.33 in"4

ly = 9333.33 in"4
Clear cover = 1.50 in
kx(sway) = N/A
ky(sway) = N/A
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STRUCTUREPOINT - spColumn v5.50 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples—Manual\Example02.col

General Information:

File Name: C:\Program Files
Project: spColumn Manual Example 2

Column: Wang 15.18.5
Code: ACI 318-14

Run Option: Investigat
Run Axis: Biaxial

Material Properties:

Concrete: Standard

ol = 4.5 ksi

Ec = 3823.68 ksi

fe = 3.825 ksi

Eps_u = 0.003 in/in

Betal = 0.825
Section:

Rectangular: Width = 2

Gross section area, Ag

Ix = 4573.33 in™4
rx = 4.04145 in
Xo = 0 in

Bar Set: ASTM A615

ion

0 in

280 in*2

Engineer:

SP

Units: English

Slenderness:

Considered

Column Type: Structural

Steel: Standard

fy = 50 ksi

Es = 29000 ksi

Eps_yt = 0.00172414 in/in
Depth = 14 in

Iy = 9333.33 in™4

ry = 5.7735 in

Yo = 0 in

Size Diam (in) Area (in”"2) Size Diam (in) Area {in”"2) Size Diam (in) Area
# 3 0.38 0.11 $ 4 0.50 0.20 # 5 0.63
# 6 0.75 0.44 7 0.88 0.60 # 8 1.00
# 9 L33 1.00 # 10 1.27 14277 # 11 1.41
# 14 1.69 2.25 # 18 2.26 4.00
Confinement: Tied; #3 ties with #11 bars, #4 with larger bars.
phifa) = 0.8, phi(b) = 0.9, phi{c) 0.65
Layout: Rectangular
Pattern: Sides Different (Cover to longitudinal reinforcement)
Total steel area: As = 9.36 in”2 at rho = 3.34%
Minimum clear spacing = 3.39 in
Top Bottom Left Right
Bars 2 $#11 2 $11 1 #11 1 #11
Cover (in) 1.5 1D L5 5]
Service Loads:
Load Axial Load Mx @ Top Mx @ Bot My @ Top My @ Bot
No. Case kip k=ft k-ft k-ft k-ft
1 Dead 0.00 0.00 0.00 0.00 0.00
Live 71.88 0.00 0.00 174.38 -174.38
Wind 0.00 0.00 0.00 0.00 0.00
EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00

Sustained Load Factors:

Load Factor
Case (%)
Dead 100
Live 0
Wind o]
EQ 0
Snow ]

Load Combinations:

Ul

1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.500*Snow

(x86) \StructurePoint\spColumn\Examples\Examples-Manual\Example02.col

(in~2)

Page 2
10/25/16
10:14 AM
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STRUCTUREPOINT - spColumn v5.50 (TM) Page 3
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F 10/25/16
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples—Manual\Example02.col 10:14 AM
Slenderness:
Sway Criteria:
X-axis: Nonsway column.
Y-axis: Nonsway column.
Height Width Depth I £ra Ec
Column Axis ft in in in”4 ksi ksi
Design X 225 20 14 4573.33 4.5 3823.68
k'S 22.5 20 14 9333.33 4.5 3823.68
Above X {no column specified...)
¥ {no column specified...)
Below X (no column specified...)
' (no column specified...)
X-Beams Length Width Depth I 3 i o] Ec
Location ft in in in*4 ksi ksi
Above Left (no beam specified...)
Above Right (no beam specified...)
Below Left (no beam specified...)
Below Right (no beam specified...)
Y-Beams Length Width Depth I fle Ec
Location £t in in in™4 ksi ksi
Above Left (no beam specified...)
Above Right (no beam specified...)
Below Left (no beam specified...)
Below Right (no beam specified...)
Effective Length Factors:
Axis Psi(top) Psi (bot) k (Nonsway) k (Sway) klu/r
X 0.000 0.000 1.000 {N/R) 66.81
¥: 0.000 0.000 1.000 {N/R) 46.77
Moment Magnification Factors:
stiffness reduction factor, phi(K) = 0.75
Cracked-section coefficients: cI(beams) = 0.35; cI{columns) = 0.7
0.2*%Ec*Ig + Es*Ise (X-axis) = 7.66e+006 kip-in*2
0.2*Ec*Ig + Es*Ise (Y-axis) = 2.36e+007 kip-in*2
X=axils: —ro-ms—mromms—mre—s At Ends Along Length — -
Ld/Comb SumPu (kip) Pc(kip) SumPc{kip) Betads Deltas Pu(kip) k'lu/r Pc(kip) Betad Cm Delta
1ul (N/A) (N/A) {N/A) (N/A) (N/A) 115.00 (N/A) 1036.79 0.000 1.000 1.174
Yedkie: =momsm—mmmmsnoeooeo At Ends Along Length —————-———————————
Ld/Comb SumPu (kip) Pc(kip) SumPc{kip) Betads Deltas Pu(kip) k'lu/r Pc(kip) Betad Cm Delta
101 (N/A) (N/RA) (N/A) ({N/A) (N/A) 115.00 (N/A) 319%.27 0.000 1.000 1.050
Factored Moments due to First-Order and Second-Order Effects:
Minimum eccentricity, Ex,min = 1.02 in
Minimum eccentricity, Ey,min = 1.2 in
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
Koty somscmoamm Ist Order sm—w—simmomo=: e 2nd Order —------- - Ratio -
Load Mns Ms Mu Mmin Mi Mc  2nd/1st
Combo k-ft k-ft k-ft k-ft k-ft k-ft
101 0.00 (N/A) 0.00 9.78 Mil= 0.00 11.47 1.174
-0.00 (N/A) -0.00 9.78 M2= -0.00 11.47 1.174
Y-axis —--——————————— lst Order -----—---—-——  ————————— 2nd Order —-—-----— - Ratio -
Load Mns Ms Mu Mmin Mi Mc 2nd/1st
Combo k-ft k-ft k-ft k-ft k-ft k-ft
101 27%.00 (N/A) 279%.00 11.50 Mil= 27%.00 293.04 1.050
279.00 (N/A) 279.00 11.50 M2= 279.00 293.04 1.050
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STRUCTUREPOINT - spColumn v5.50 (TM) Page 4
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F 10/25/16
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples—Manual\Example02.col 10:14 AM

Factored Loads and Moments with Corresponding Capacities:

NOTE: Each loading combination includes the following cases:

First line - at column top
Second line - at column bottom
Load Pu Mux Muy PhiMnx PhiMny PhiMn/Mu NA depth Dt depth eps_t Phi
No. Combo kip k-ft k-ft k-ft k-ft in in
1 1vul 115.00 11.47 293.04 13.83 353.32 1.206 5.19 18.77 0.00810 0.9%00
2 115.00 11.47 293.04 13.83 353.32 1.206 5.19% 18.77 0.00810 0.%00

**% End of output ***
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Example 2 - Design of a Slender Column in a Sway Frame

Design a square column? with a clear height of 16 ft. The column is sway and subjected to dead, live and

wind loads as shown below.

Dead Live Wind
P (kip) 380 140 0
Top M, (kip-ft) 32 20 50
Bottom M (kip- 54 36 50
ft)

The column is to be checked for the following load combinations:

Ul=12D+16L

U2=12D+05L+16W

The calculations in the reference are done based on the load combination
u2.

In practice, the ratio P,/ P. would have to be calculated before the
problem can be attempted, using a trial value of XP./P.. Here, the value of
YP./P.used is 28.67 based on the reference value of P.. There are 14 interior
columns, 18 exterior columns and 4 corner columns. Therefore, the value of
YP/P,=14+18 * 2/3 + 4 * 1/3 = 27.33 irrespective of the load combination
being used.

1. From the File menu, choose New. Any input data is cleared and the
default values are restored.

2. From the Input menu, choose General Information.

e Input the PROJECT header.

e  Select English units and ACI 318-14 code.

E
— Labelz
Froject:
IspEqumn M anual Example 3
Colurn: Engineer:
IHassoun12.4 SP
— Design Code
Jaci 31814 =l
— Unitg Fun Option
* English 7 Irrvestigation
" Mehic & Design
r Run Axi
1 About Mabis " Biaxial
1 About Y-uis

Consider slendemmess?  Yes  No

LCancel

e Select About X-Axis for run axis, Design for run option and Yes for Consider slenderness?

e Choose OK.

3. From the Input menu, pick Material Properties.

e Input 5 for the concrete strength. Other properties are computed and will be accepted.

e Choose OK.

2 Based on Example 12.4, pp 409, from Structural Concrete: Theory and Design by M. Nadim Hassoun and Akthem Al-Manaseer, Fourth

Edition, 2008, John Wiley and Sons, Inc.

10
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ﬂ
i Concrete i Reinfarcing Steel
Strength, f'c |5— ks Strength, fy: IBD— ksi
[V Standard IV Standard
Blasticity. Ee: [03051 ks | | Elasticiy Es[29000 ksi
Max stress, fo: |425— ksi

Beta[1]: ID.S Compression-controlled strain limit,
Ultimate: strain: ID.DDS Eps_wt ID.DD2DBSS?

Lancel |

4. From the Input menu, pick Section | Rectangular.

e Input 18 and 18 for the WIDTH (ALONG X) and DEPTH (ALONG Y) under both START and END options.

e Choose OK.

Rectangular, Section

Start End Increment

‘width [alang X): 18 il in
Depth [alongv): |18 18 1] in

] 4 LCancel |

5. From the Input menu, choose Reinforcement | All Sides Equal

e Input 4-#10 bars for Minimum, and 40-#10 bars for Maximum and 1. 5 in for the cover, and select
TRANSVERSE BARS and RECTANGULAR Bar Layout.

e Choose OK.

All Sides Equal X

Cover to
Minirmurn — Maximum
(¢ Transverse barg

No. of bars: 40 " Longitudinal bars
Bar gize: #10 = | [#10 = Bar Layaut

. + Rectangular
Clear cover: |1.5 in i Y
" Circular

ok LCancel |

6. From the Input menu, choose Slenderness | Design Column.

e Input 16 for the column CLEAR HEIGHT.

e Check SwAY FRAME

e Under SWAY CRITERIA, input 28 .67 and 27 . 33 for the XPc/Pc and ZPu/Pu, respectively.
e Leave 2"° ORDER EFFECT ALONG LENGTH option checked (default)

e Select COMPUTE ‘K’ FACTORS.

e Choose OK.

11
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Design Column g|
Hebinis fAuis
Clear height; ft Clear height; l_ ft
" Monsway frarme o
(* Sway frame (=
Sway criteria Sway criteria
{Sum PeliPe) [2867 {Sum PelPe [0 58
{Sum Pul/Pu) [27.33 [Sum Pul/Pul [2174
¥ 2'nd order effects along length ¥
Effective length factors Effective length factors
* Compute k' factors .
" Input 'k' factaors: {=
Kinsk [0525 Kesl: [1408 kinsk [08 kisk [157
_ Comoians | _ comioians |
ok LCancel |

7. From the Input menu, choose Slenderness | Columns Above/Below.
e Clear the NO COLUMN SPECIFIED option.

e Input 11 for the column height (center-to-center) under HEIGHT (C/C) and leave the other data as is.
e Choose Copy to Column Below.

e Choose OK.

X

Columns Above and Below

Calumn Above Calurnn Below

™ Mo column specified

Height [e/el  [11 g Heightic/el 1T ¢
width (albong =5 18 g width (along X [18° iy
Depth [along *): 'F i Depth [along ] IT i
Concrete,  fio: ’5— ksi Concrete, o I5— ki

Ec: 40300 |4 Ec: 4030, g
Copy ta Calurnn Below | Copy ta Colurit Abave |
ak. LCancel |

8. From the Input menu, choose Slenderness | X-Beams.
e Choose ABOVE LEFT.

e  Clear the NO BEAM SPECIFIED option.

e Input 20 for the span (center-to-center) under SPAN(C/C).

e Input0.00and 0.00 for the WIDTH and DEPTH, respectively.
e Input21436. 6 for the moment of inertia under INERTIA.

e Leave the other data as it is.

e Choose ABOVE RIGHT and click on CorY FROM BEAM LEFT.

e Choose BELOW LEFT and click on CorY FROM BEAM ABOVE.

12
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e Choose BELOW RIGHT and click on Cory FROM BEAM ABOVE.

e Choose OK.

%-Beams (perpendicular to X) rg|

Beam Location:

" Ahove Right

" Below Left " Below Right

Beam Above Left

[~ Mo beam speciied  Copy From Beam Right

Span[cfc] |20 ft f'e: |5 ki
“fidth: ] in
Depth: 1] in Inertia; |21436.6 "4

Ec: [4030.57 kai

ak Lancel |

9. From the Input menu, choose Loads | Service.

e Under DEAD, input 380, 32 and -54 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS

respectively.

e Under LIVE, input 140, 20 and -36 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS,

respectively.

e Under WIND, input 0, 50 and -50 for the AXIAL LOAD, X-MOMENTS and Y-MOMENTS, respectively.

Service Loads

&5

Auial Load [kip]—— *-Moments [k-ft] r-homents [k-ft] Sustained Load [%)
@ Top @ Bat @ Top @ Bat
Dead | [330 [32 [-54 [ [ [100
Live: | [140 [20 K [ [ [
wind | [0 |50 [50 | [ o
B | [0 [0 [0 | | Io
Snow: | |0 o o [ [ [
Insert ‘ Modify | Delete |

1

|N0. [P, bdxt, bxb, Myt, bub] for each case

ar LCancel |

e Under SUSTAINED LOAD keep the default settings of 100% for dead and 0% for all other load cases.

e Choose INSERT to add the entry to the list box.

e Choose OK.

10. From the Input menu, choose Loads | Load Combinations.

13
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o [f the list displays thirteen combinations, leave the first and second as they are. Delete the remaining
combinations using DELETE.

Load Combinations le

Dead Live wind EQ Show

e The solver of the program is started and, upon completion, +Jos +fie o+ o+ o5
displays the interaction diagram of the section with the it ]

11. From the Solve menu, choose Execute.

. . . b odif Delet Drefault:
load points plotted within the diagram. El o || [oers]
| Combio Dead Live “wind EQ Show
12. From the View menu, choose Results. 0 1z 6 0 0 05

e Page through the results file.

e Choose Exit to quit the spView program and get back to
spColumn.

13. From the File menu, choose Print Results.
e  Select the printer to send the text results to.
e Choose PRINT.
14. From the File menu, choose Print Screen.
e  Select the printer to send the graphical results to.
e Choose PRINT.

ok Cancel

14
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P (kip)
2500 +
O O O O
O y O
4
O O
fs=0 (Pmax) i _(Pmax) ™ fs=0
O O O O
fs=0.5fy / fs=0 fs=0 », fs=0.5fy
18 x 18 in fs=0.5fy / 112 \f5=0.5fy
{ // iR \\\ !
Code: ACI 318-14 / \
Units: English // \\\
/ \
Run axis: About X-axis | ‘ ‘ ‘ ‘ ) 7
I T T T T T
Run option: Design -600 600
) Mx (k-ft)
Slenderness: Considered
Column type: Structural
Bars: ASTM A615
Date: 10/25/16 (Pmin) (Pmin)

Time: 10:20:13

-1000

STRUCTUREPOINT - spColumn v5.50 (TM). Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F

Project: spColumn Manual Example 3

Confinement: Tied
phi(a) = 0.8, phi(b) = 0.9, phi(c) = 0.65

Column: Hassoun 12.4 Engineer: SP

f'c =5 ksi fy =60Kksi Ag = 324 in"2

Ec = 4031 ksi Es =29000 ksi As =15.24 in"2

fc = 4.25 ksi e_yt=0.00206897 infin  Xo =0.00in
e_u=0.003in/in Yo =0.00in

Beta1 =0.8 Min clear spacing = 3.06 in

kx(nonsway) = 0.802212

File: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example03.col

12 #10 bars

rho =4.70%

Ix = 8748 in"4

ly = 8748 in4

Clear cover = 1.88 in
kx(sway) = 1.38998

15
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STRUCTUREPOINT - spColumn v5.50 (TM)
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F

C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples—Manual\Example03.col

General Information:

File Name: C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples-Manual\Example03.col

Project: spColumn Manual Example 3

Column: Hassoun 12.4 Engineer: SP

Code: ACI 318-14 Units: English

Run Option: Design Slenderness: Considered
Run Axis: X-axis Column Type: Structural

Material Properties:

Concrete: Standard Steel: Standard
pgta] = 5 ksi fy = 60 ksi
Ec = 4030.51 ksi Es = 29000 ksi
fec = 4.25 ksi Eps_yt = 0.00206897 in/in
Eps_u = 0.003 in/in
Betal = 0.8
Section:
Rectangular: Width = 18 in Depth = 18 in
Gross section area, Ag = 324 in"2
Ix = 8748 in™4 Iy = 8748 in”4
rx = 5.198615 in ry = 5.19615 in
Xo = 0 in Yo = 0 in
Bar Set: ASTM A615
Size Diam (in) Area (in”"2) Size Diam (in) Area {in”"2) Size Diam (in) Area
# 3 0.38 0.11 # 4 0.50 0.20 # 5 0.63
# 6 0.75 0.44 # 7 0.88 0.60 # 8 1.00
# 9 L33 1.00 # 10 1.27 14277 # 11 1.41
# 14 1.69 2.25 # 18 2.26 4.00
Bar selection: Minimum number of bars
Asmin = 0.01 * Ag = 3.24 in”2, Asmax = 0.08 * Ag = 25.92 in"2
Confinement: Tied; #3 ties with #10 bars, #4 with larger bars.
phi{a) = 0.8, phi(b) = 0.9, phi{c) = 0.65
Layout: Rectangular
Pattern: All Sides Equal (Cover to transverse reinforcement)
Total steel area: As = 15.24 in”2 at rho = 4.70%
Minimum clear spacing = 3.06 in
12 #10 Cover = 1.5 in
Service Loads:
Load Axial Load Mx @ Top Mx @ Bot My @ Top My @ Bot
No. Case kip k=ft k-ft k-ft k-ft
1 Dead 380.00 32.00 -54.00 0.00 0.00
Live 140.00 20.00 -36.00 0.00 0.00
Wind 0.00 50.00 -50.00 0.00 0.00
EQ 0.00 0.00 0.00 0.00 0.00
Snow 0.00 0.00 0.00 0.00 0.00
Sustained Load Factors:
Load Factor
Case (%)
Dead 100
Live o]
Wind o]
EQ 0
Snow 0
Ul = 1.200*Dead + 1.600*Live + 0.000*Wind + 0.000*EarthQuake + 0.500*Snow

U2 = 1.200*%Dead + 0.500*Live + 1.600*Wind + 0.000*EarthQuake + 0.500*Snow

(in~2)

Page 2
10/25/16
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STRUCTUREPOINT - spColumn v5.50 (TM) Page 3
Licensed to: StructurePoint. License ID: 00000-0000000-4-2A05D-2206F 10/25/16
C:\Program Files (x86)\StructurePoint\spColumn\Examples\Examples—Manual\Example03.col 10:19 AM
Slenderness:
Sway Criteria:
X-axis: Sway column. SumPc = 28.67 * Pc SumPu = 27.33 * Pu
Second-order effects along length considered
Height Width Depth I £ra Ec
Column Axis ft in in in”4 ksi ksi
Design X 16 18 18 8748 5 4030.51
Above X 1 18 18 8748 5 4030.51
Below X 14, 18 18 8748 5 4030.51
X-Beams Length Width Depth T £rée Ec
Location EE in in in”4 ksi ksi
Above Left 20 0 0 21436.6 5 4030.51
Above Right 20 0.0001 0.0001 21436.6 5 4030.51
Below Left 20 0.0001 0.0001 21436.6 5 4030.51
Below Right 20 0.0001 0.0001 21436.6 5 4030.51
Effective Length Factors:
Axis Psi(top) Psi{bot) k {(Nonsway) k (sway) klu/r
X 1.252 1.252 0.802 1.390 51.36
Moment Magnification Factors:
Stiffness reduction factor, phi(K) = 0.75
Cracked-section coefficients: cI{beams) = 0.35; cI{columns) = 0.7
0.2*Ec*Ig + Es*Ise (X-axis) = 2.02e+007 kip-in”"2
Koanla: mososs—cos s At Ends Aloeng: Length:—=c=—rma———mmmm———
Ld/Comb SumPu(kip) Pc(kip) SumPc{kip) Betads Deltas Pu(kip) k'lu/r Pc(kip) Betad Cm Delta
1ul 18584.40 2792.45 80059.54 0.000 1.448 680.00 (N/R) 5018.30 0.671 0.830 1.013
U2 14375.58 2792.45 80059.54 0.000 1.315 526.00 (N/A) 4490.56 0.867 0.927 1.098
Factored Moments due to First-Order and Second-Order Effects:
Minimum eccentricity, Ex,min = 1.14 in
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
X-axis ———————r 1lst order —————————  ——————— 2nd Order ———————- - Ratio -
Load Mns Ms Mu Mmin Mi Mc 2nd/1st
Combo k-ft k-ft k-ft k-ft k-ft k-ft
1 Ul 70.40 0.00 70.40 64.60 Ml= 70.40 71532 1.013
122.40 -0.00 122.40 64.60 M2= 122.40 124.00 1.013
102 48.40 80.00 128.40 49.97 Mil= 153.58 168.69 1.314
82.80 80.00 162.80 49.97 M2= 187.98 206.47 1.268
Factored Loads and Moments with Corresponding Capacities:
Design/Required ratio PhiMn/Mu >= 1.00
NOTE: Each loading combination includes the following cases:
First line - at column top
Second line - at column bottom
Load Pu Mux PhiMnx PhiMn/Mu NA depth Dt depth eps_t Phi
No. Combo kip k-ft k-ft in in
1 1ul 680.00 71.32 311.55 4.368 12.43 15.49 0.00074 0.650
2 680.00 124.00 311.55 2.512 12.43 15.49 0.00074 0.650
3 1uU2 526.00 168.69 344.47 2.042 10.76 15.49 0.00132 0.650
4 526.00 206.47 344.47 1.668 10.76 15.49 0.00132 0.650

*** End of output ***
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